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1. Цель освоения дисциплины  

 овладение современными средствами компьютерной графики, современным 

программным обеспечением, связанным с подготовкой и редактированием документов, ана-

лизом и хранением данных, поиском информации, коммуникацией;   

 формирование представлений об основных принципах построения и функцио-

нирования компьютерных систем и программного обеспечения, позволяющих самостоятель-

но овладевать непрерывно появляющимися новыми техническими и программными сред-

ствами.   

 

2. Место дисциплины в структуре ОПОП магистратуры 

Дисциплина «Компьютерные технологии в дизайне» входит в вариативную часть ос-

новной профессиональной образовательной программы по направлению 54.04.01 «Дизайн». 

Для освоения дисциплины «Компьютерные технологии в дизайне» необходимы зна-

ния   и компетенции, сформированные в результате изучения дисциплин общенаучного цик-

ла «Философские проблемы науки и техники». 

В результате освоения дисциплины «Компьютерные технологии в дизайне» форми-

руются знания и умения, необходимые для успешного освоения дисциплин профессиональ-

ного цикла: «Дизайн-проектирование», «Авторская графика в дизайне», «Фотографика в ди-

зайне», «Графический дизайн в рекламе», «Графический дизайн в полиграфии». 

 

3. Планируемые результаты обучения по дисциплине, соотнесённые с планируе-

мыми результатами освоения образовательной программы. 

Изучение дисциплины направлено на формирование следующих компетенций и 

индикаторов их достижения. 

 

Код и наименование ком-

петенции 

Индикаторы достижения компетенций  

Знать  Уметь  Владеть  

УК-4 Коммуникация. Спо-

собен применять современ-

ные коммуникативные тех-

нологии, в том числе на ино-

странном(ых) языке(ах), для 

академического и професси-

онального взаимодействия. 

УК-4  

основы деловой 

коммуникации, 

особенности ее 

осуществления в 

устной и письмен-

ной формах на рус-

ском и иностран-

ном языке  

УК-4  

налаживать и 

осуществлять де-

ловые коммуника-

ции в устной и 

письменной фор-

мах на русском и 

иностранном язы-

ке; выявлять и 

устранять соб-

ственные ошибки, 

строить выступле-

ние в соответствии 

с коммуникатив-

ным замыслом, 

свободно держать-

ся перед аудито-

рией, осуществ-

лять обратную 

связь с ней  

УК-4  

навыками дело-

вой коммуни-

кации в устной 

и письменной 

формах на рус-

ском и ино-

странном языке 

в условиях по-

ликультурной 

среды  

ПК-4 Компьютерное ма-

стерство 

 

ПК-4  
основы информа-

ционно-

коммуникационных 

технологий и паке-

ПК-4  
осуществлять 

компьютерную 

обработку инфор-

мации на высоком 

ПК-4  
способами  

графического  

компьютерного 

моделирования  
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ты компьютерных 

графических редак-

торов  

художественном 

уровне и ее графи-

ческое представ-

ление в дизайн-

проекте  

 

Перечень обобщённых трудовых функций и трудовых функций, имеющих отношение к про-

фессиональной деятельности выпускника  

 

Профессиональный 

стандарт 

Обобщенные трудо-

вые функции 

Трудовые функции 

Профессиональный 

стандарт 11.013 

«Графический ди-

зайнер»: приказ 

Министерства тру-

да и социальной 

защиты РФ от 

17.01.2017 г. № 40н 

Разработка систем ви-

зуальной информации, 

идентификации и 

коммуникации 

Проведение предпроектных дизайнерских 

исследований 

Разработка и согласование с заказчиком про-

ектного задания на создание систем визуаль-

ной информации, идентификации и комму-

никации 

Концептуальная и художественно-

техническая разработка дизайн-проектов си-

стем визуальной информации, идентифика-

ции и коммуникации 

Авторский надзор за выполнением работ по 

изготовлению в производстве систем визу-

альной информации, идентификации и ком-

муникации 

Руководство деятель-

ностью по разработке 

объектов и систем ви-

зуальной информации, 

идентификации и 

коммуникации 

Планирование работ по разработке объектов 

и систем визуальной информации, иденти-

фикации и коммуникации 

Организация работ по выполнению дизайн-

проектов объектов и систем визуальной ин-

формации, идентификации и коммуникации 

Контроль изготовления в производстве ди-

зайн-проектов объектов и систем визуальной 

информации, идентификации и коммуника-

ции 

 

4. Объем, структура и содержание дисциплины «Компьютерные технологии в ди-

зайне» 

 

4.1. Объем дисциплины  

Очная форма обучения 

Общая трудоемкость дисциплины составляет 6 зачетных единиц, 216 академических 

часа, в том числе 74 часов контактной (аудиторной) работы с обучающимися, 109 часов - 

самостоятельная работа обучающихся, 27 часов - подготовка к экзаменам. 

74 часов (100%) аудиторной работы проводится в интерактивных формах. 

 

Заочная форма обучения 

Общая трудоемкость дисциплины составляет 6 зачетных единиц, 216 академических 

часа, в том числе 18 часов контактной (аудиторной) работы с обучающимися, 189 часов - 

самостоятельная работа обучающихся, 9 часов - подготовка к экзаменам. 

18 часов (100%) аудиторной работы проводится в интерактивных формах. 
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Практическая подготовка при реализации учебной дисциплины организуется путем 

проведения практических занятий, предусматривающих участие обучающихся в выполнении 

отдельных элементов работ, связанных с будущей профессиональной деятельностью. 

Практическая подготовка включает в себя отдельные занятия лекционного типа, кото-

рые предусматривают передачу учебной информации обучающимся, необходимой для по-

следующего выполнения работ, связанной с будущей профессиональной деятельностью. 

 
4.2. Структура дисциплины (очная форма обучения) 

№ 

пп 
Раздел дисциплины 

С
ем

ес
тр

 

З
ач

ет
. 
ед

и
н

и
ц

а 

В
се

го
 

Виды учебной работы,  

в т.ч. 

СРС и трудоемкость  

(в час.) 

В т.ч. ауд. 

занятия в интерактив-

ной форме* 

л
ек

ц
и

и
 

П
р

ак
ти

ч
./

 

л
аб

о
р

ат
о

р
н

ы
е 

И
З
 

С
Р

С
 

эк
за

м
ен

  

1 Раздел 1. Аппаратные и 

программные средства 

IBM-совместимых пер-

сональных компьютеров 

(РС). Работа в среде ло-

кальных и глобальных 

компьютерных сетей 

1 2 72 

2* 6*  14 - Дискуссия - 2*  

Просмотр заданий - 6* 

 

2 Раздел 2. Пакет при-

кладных программ Mi-

crosoft Office 

3* 6* 2 14 - Дискуссия - 3*  

Просмотр заданий - 6* 

 

3 Раздел 3. Специализиро-

ванные профессионально 

ориентированные про-

граммные средства 

3* 6*  16 - Дискуссия - 3*  

Просмотр заданий - 6* 

4 Раздел 4. Специализиро-

ванные профессионально 

ориентированные про-

граммные средства 

2-3 4 144 16* 32* 4 65 27 Дискуссия - 16*  

Просмотр заданий - 

32* 

 Итого: 216  6 216 24* 50* 6 109 27 74 

 
Структура дисциплины (заочная форма обучения) 

№ 

пп 
Раздел дисциплины 

С
ем

ес
тр

 

З
ач

ет
. 
ед

и
н

и
ц

а 

В
се

го
 

Виды учебной работы,  

в т.ч. 

СРС и трудоемкость  

(в час.) 

В т.ч. ауд. 

занятия в интерактив-

ной форме* 

л
ек

ц
и

и
 

П
р
ак

ти
ч
./

 

л
аб

о
р
ат

о
р
н

ы
е 

С
Р

С
 

эк
за

м
ен
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1 Раздел 1. Аппаратные и 

программные средства 

IBM-совместимых пер-

сональных компьютеров 

(РС). Работа в среде ло-

кальных и глобальных 

компьютерных сетей 

1 2 72 

1* 1* 22 - Дискуссия - 1*  

Мультимедийная пре-

зентация - 1* 

2 Раздел 2. Пакет при-

кладных программ Mi-

crosoft Office 

 1* 22 - Дискуссия - 1*  

 

3 Раздел 3. Специализиро-

ванные профессионально 

ориентированные про-

граммные средства 

1* 2* 22 - Просмотр заданий - 1* 

Мультимедийная пре-

зентация - 2* 

4 Раздел 4. Специализиро-

ванные профессионально 

ориентированные про-

граммные средства 

2-3 4 144 4* 8* 123 9 Дискуссия - 4*  

Просмотр заданий - 8* 

 Итого: 216  6 216 6* 12* 189 9 18 

 

4.3. Содержание дисциплины 

№ 

п/п 

Содержание дисциплины  

(Разделы. Темы) 

Результаты обучения Виды оценочных 

средств; формы те-

кущего контроля, 

промежуточной 

аттестации 

Раздел 1. Аппаратные и программные средства IBM-совместимых персональных 

компьютеров (РС). Работа в среде локальных и глобальных компьютерных сетей 

1 1. Современный компьютер как сово-

купность аппаратуры и программных 

средств, предназначенная для обра-

ботки информации. Структурная схема 

компьютера.  2. Структура программ-

ного обеспечения современного пер-

сонального компьютера и назначение 

отдельных составляющих программ-

ного обеспечения. Системное про-

граммное обеспечение (операционная 

система, базовая система вво-

да/вывода).  

3. Прикладное программное обеспече-

ние и его разновидности. Системы 

программирования. 

4. Основные компоненты операцион-

ной системы Windows.  Свойства опе-

рационной системы Windows: много-

задачность, графический интерфейс, 

технология «plug and play», встроенная 

поддержка сетевых возможностей. Ос-

новные понятия, связанные с управле-

Формируемые компетен-

ции: 
способен применять совре-

менные коммуникативные 

технологии, в том числе на 

иностранном (ых) языке 

(ах), для академического и 

профессионального взаи-

модействия (УК-4). 

способен эффективно ис-

пользовать специальные 

компьютерные программы 

для создания дизайн-

проектов (ПК-4) 

В результате изучения 

раздела студент должен: 

знать: 
 основы деловой ком-

муникации, особенности ее 

осуществления в устной и 

письменной формах на рус-

ском и иностранном языке 

Тестовый 

контроль 

Защита прак-

тических за-

даний 
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нием работой прикладных программ в 

среде операционной системы 

Windows.  

5. Программы для работы с файлами и 

папками в среде Windows («файловые 

менеджеры»). Сервис файловой си-

стемы: проверка целостности системы, 

упорядочение диска, резервное копи-

рование и архивирование. Обмен дан-

ными между приложениями, работа-

ющими в среде Windows, буфер обме-

на Windows, внедрение и связывание 

объектов. 

6. Локальные и глобальные компью-

терные сети, основные характеристики 

и тенденции развития. Структура сети. 

Основные функции сети. Важнейшие 

технические параметры сети. Устрой-

ство локальных и корпоративных се-

тей (на примере сети КемГИК).   

7. Работа в глобальной сети Internet, 

использование электронной почты и 

других информационных служб 

(WWW, FTP и др.). Работа с WWW 

браузерами (Microsoft Internet 

Explorer). 

8. Защита информации в локальных и 

глобальных компьютерных сетях, 

шифрование, электронная цифровая 

подпись, антивирусная защита. 

(УК-4) (З-4); 

 основы информаци-

онно-коммуникационных 

технологий и пакеты ком-

пьютерных графических 

редакторов (ПК-4) (З4); 

уметь: 
 налаживать и осу-

ществлять деловые комму-

никации в устной и пись-

менной формах на русском 

и иностранном языке;  вы-

являть и устранять соб-

ственные ошибки, строить 

выступление в соответ-

ствии с коммуникативным 

замыслом, свободно дер-

жаться перед аудиторией, 

осуществлять обратную 

связь с ней (УК-4) (У-4); 

осуществлять компьютер-

ную обработку информации 

на высоком художествен-

ном уровне и ее графиче-

ское представление в ди-

зайн-проекте (ПК-4) (У4). 

владеть: 
 навыками деловой 

коммуникации в устной и 

письменной формах на рус-

ском и иностранном языке 

в условиях поликультурной 

среды (УК-4) (В-4); 

 способами  графиче-

ского  компьютерного мо-

делирования (ПК-4) (В4). 

Раздел 2. Пакет прикладных программ Microsoft Office 

2 1. Общие сведения о пакетах «офис-

ных» прикладных программ Microsoft 

Office и Open Office (состав пакетов, 

назначение отдельных программ).  

2. Пакет Microsoft Office. 2.1. Тексто-

вый редактор Microsoft Word: назна-

чение, основные возможности работы 

с текстом, форматирование документа 

и текста (простейшие полиграфиче-

ские понятия: поля, колонтитулы, аб-

зац и его параметры, шрифт и его па-

раметры), таблицы, возможности ра-

боты с графикой, ввод и редактирова-

ние математических формул, понятие 

о стилях и шаблонах.  

Формируемые компетен-

ции: 
способен применять совре-

менные коммуникативные 

технологии, в том числе на 

иностранном (ых) языке 

(ах), для академического и 

профессионального взаи-

модействия (УК-4). 

способен эффективно ис-

пользовать специальные 

компьютерные программы 

для создания дизайн-

проектов (ПК-4) (ПК-4) 

В результате изучения 

Тестовый 

контроль 

Защита прак-

тических за-

даний 
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2.2. Электронные таблицы Microsoft 

Excel. Применение электронных таб-

лиц: вычисления, анализ данных, под-

держка принятия решений. Организа-

ция работы с документом Excel (рабо-

чая книга, рабочий лист). Основные 

понятия (ячейка, формула, относи-

тельная ссылка, абсолютная ссылка, 

смешанная ссылка). Операции с объ-

ектами рабочего листа (копирование, 

перемещение, распространение, фор-

матирование), построение и редакти-

рование диаграмм, стандартные функ-

ции рабочего листа, статистический 

анализ данных, надстройки Excel 

(«Подбор параметра», «Поиск реше-

ния», «Пакет анализа»). 

2.3. Система управления базами дан-

ных (СУБД) Microsoft Access. Модели 

данных. Реляционная модель. Струк-

тура базы данных, основанной на ре-

ляционной модели. Назначение и кон-

струирование таблиц, запросов, форм 

и отчетов. Связи в реляционной базе 

данных. Эксплуатация баз данных: 

концепции файл-сервер и клиент-

сервер. 

2.4. Обмен данными между докумен-

тами различных программ пакета 

Microsoft Office. Программа подготов-

ки и демонстрации презентаций 

Microsoft PowerPoint.  

2.5. Сканирование изображений. Оп-

тическое распознавание текста, каче-

ство распознавания. Программы для 

сканирования изображений и оптиче-

ского распознавания текста: Microsoft 

Office Document Scanning и Microsoft 

Office Document Imaging. Сравнение 

современных программ оптического 

распознавания текста.  

2.6. Обработка графической информа-

ции, растровая и векторная графика. 

Программа для редактирования гра-

фики Microsoft Office Picture Manager. 

раздела студент должен: 

знать: 
 основы деловой ком-

муникации, особенности ее 

осуществления в устной и 

письменной формах на рус-

ском и иностранном языке 

(УК-4) (З-4); 

 основы информаци-

онно-коммуникационных 

технологий и пакеты ком-

пьютерных графических 

редакторов (ПК-4) (З4); 

уметь: 
 налаживать и осу-

ществлять деловые комму-

никации в устной и пись-

менной формах на русском 

и иностранном языке;  вы-

являть и устранять соб-

ственные ошибки, строить 

выступление в соответ-

ствии с коммуникативным 

замыслом, свободно дер-

жаться перед аудиторией, 

осуществлять обратную 

связь с ней (УК-4) (У-4); 

осуществлять компьютер-

ную обработку информации 

на высоком художествен-

ном уровне и ее графиче-

ское представление в ди-

зайн-проекте (ПК-4) (У4). 

владеть: 
 навыками деловой 

коммуникации в устной и 

письменной формах на рус-

ском и иностранном языке 

в условиях поликультурной 

среды (УК-4) (В-4); 

 способами  графиче-

ского  компьютерного мо-

делирования (ПК-4) (В4). 

Раздел 3. Специализированные профессионально ориентированные программные 

средства 

3 1. Обзор программного обеспечения 

в области издательских систем. По-

лиграфия: основные понятия.  

2. Рабочая область программы 

InDesign, палитра инструментов. 

Формируемые компетенции: 
способен применять совре-

менные коммуникативные 

технологии, в том числе на 

иностранном (ых) языке (ах), 

Тестовый 

контроль 

Защита прак-

тических за-

даний 
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Создание многостраничного доку-

мента. Работа с текстом и графикой. 

Форматирование. Трансформация 

объектов и работа с ними. Работа с 

таблицами. Работа со стилями. За-

грузка стилей, вложенные стили. 

Работа с цветом. Градиент, созда-

ние образцов. Работа с печатью. 

Проверка предварительная, сборка 

для переноса в типографию, окно 

"Печать". Экспорт. Работа с различ-

ными форматами. Основы создания 

и разработки веб-сайтов и прило-

жений. 

3. Особенности векторной графики 

и ее применение в дизайне. 

Векторный редактор Adobe 

Illustrator.  Упорядочение объектов. 

Операции с несколькими 

объектами. Огибающие и 

деформации. Клоны. Стандартные 

фрагменты. Пошаговые переходы и 

ореолы. Линзы. Прозрачность и 

фигурная обрезка. Размещение 

текста на траектории. Пиксельные 

изображения и коллажи.  

для академического и профес-

сионального взаимодействия 

(УК-4). 

способен эффективно исполь-

зовать специальные компью-

терные программы для созда-

ния дизайн-проектов (ПК-4) 

В результате изучения раз-

дела студент должен: 

знать: 
 основы деловой комму-

никации, особенности ее осу-

ществления в устной и пись-

менной формах на русском и 

иностранном языке (УК-4) (З-

4); 

 основы информационно-

коммуникационных техноло-

гий и пакеты компьютерных 

графических редакторов (ПК-

4) (З4); 

уметь: 
 налаживать и осуществ-

лять деловые коммуникации в 

устной и письменной формах 

на русском и иностранном 

языке;  выявлять и устранять 

собственные ошибки, строить 

выступление в соответствии с 

коммуникативным замыслом, 

свободно держаться перед 

аудиторией, осуществлять об-

ратную связь с ней (УК-4) (У-

4); 

осуществлять компьютерную 

обработку информации на вы-

соком художественном уровне 

и ее графическое представле-

ние в дизайн-проекте (ПК-4) 

(У4). 

владеть: 
 навыками деловой ком-

муникации в устной и пись-

менной формах на русском и 

иностранном языке в условиях 

поликультурной среды (УК-4) 

(В-4); 

 способами  графиче-

ского  компьютерного моде-

лирования (ПК-4) (В4). 

Раздел 4. Специализированные профессионально ориентированные программные 

средства 
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4 1. Растровый редактор Adobe 

Photoshop. Особенности растровых 

изображений и их применение в 

графическом дизайне. Выделение 

объектов. Создание слоев. Команды 

корректировки. Градиенты и 

заливки. Создание маски слоя. 

Контуры и фигуры. Работа с 

текстом. Фильтры. Предпечатная 

подготовка. 

2. Трехмерная графика и ее 

применение в графическом дизайне. 

Интерфейс Autodesk 3D Studio Max. 

Создание объектов. Работа с окнами 

проекций. Выделение и 

отображение объектов. 

Трансформации. Модификация 

объектов. Анимация. 

Редактирование сеток. 

Редактирование форм. Составные 

объекты. Освещение. Камеры. 

Создание материалов Работа с 

текстурными картами. 

Визуализация. 

Формируемые компетенции: 
способен применять совре-

менные коммуникативные 

технологии, в том числе на 

иностранном (ых) языке (ах), 

для академического и профес-

сионального взаимодействия 

(УК-4). 

способен эффективно исполь-

зовать специальные компью-

терные программы для созда-

ния дизайн-проектов (ПК-4) 

В результате изучения раз-

дела студент должен: 

знать: 
 основы деловой комму-

никации, особенности ее осу-

ществления в устной и пись-

менной формах на русском и 

иностранном языке (УК-4) (З-

4); 

 основы информационно-

коммуникационных техноло-

гий и пакеты компьютерных 

графических редакторов (ПК-

4) (З4); 

уметь: 
 налаживать и осуществ-

лять деловые коммуникации в 

устной и письменной формах 

на русском и иностранном 

языке;  выявлять и устранять 

собственные ошибки, строить 

выступление в соответствии с 

коммуникативным замыслом, 

свободно держаться перед 

аудиторией, осуществлять об-

ратную связь с ней (УК-4) (У-

4); 

осуществлять компьютерную 

обработку информации на вы-

соком художественном уровне 

и ее графическое представле-

ние в дизайн-проекте (ПК-4) 

(У4). 

владеть: 
 навыками деловой ком-

муникации в устной и пись-

менной формах на русском и 

иностранном языке в условиях 

поликультурной среды (УК-4) 

(В-4); 

Тестовый 

контроль 

Защита прак-

тических за-

даний 
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способами  графического  

компьютерного моделирова-

ния (ПК-4) (В4). 

 

5. Образовательные и информационно-коммуникационные технологии  

5.1. Образовательные технологии 

Для достижения планируемых результатов обучения в дисциплине «Компьютерные 

технологии в дизайне» используются различные образовательные технологии: 

1. Информационно-развивающие технологии, направленные на формирование системы 

знаний, запоминание и свободное оперирование ими. 

Используется лекционно-практический метод, самостоятельное изучение литературы, 

применение новых информационных технологий для самостоятельного пополнения знаний, 

включая использование технических и электронных средств информации. 

2. Деятельностные практико-ориентированные технологии, направленные на формиро-

вание системы профессиональных практических умений при оформлении документации и 

результатов моделирования. 

Используется анализ, сравнение информационных и программных средств, форматов 

данных, выбор наиболее эффективных средств реализации проекта. 

Для диагностики компетенций применяются следующие формы контроля: тестовый 

контроль, защита проектов, собеседование, защита мультимедийных презентаций, экзамен.  

 

5.2. Информационно-коммуникационные технологии 

Освоение дисциплины, основу которой составляют информационно-развивающие 

технологии, предполагает широкое использование двухмерного и трехмерного 

компьютерного моделирования, мультимедийных телекоммуникационных технологий. Для 

разработки учебно-творческих дизайн-проектов обучающиеся осваивают векторную и 

растровую компьютерную графику, искусство компьютерной верстки. 

Освоение учебной дисциплины «Компьютерные технологии в дизайне» предполагает 

размещение различных электронно-образовательных ресурсов на сайте электронной 

образовательной среды КемГИК и использование ее интерактивных инструментов. 

Ознакомление с данными ресурсами доступно каждому студенту посредством логина и 

пароля. Электронная образовательная среда КемГИК обеспечивает обучающимся доступ к 

учебным изданиям, учебно-методическим разработкам, фиксацию хода образовательного 

процесса и его результатов, формирование электронного портфолио обучающихся, 

взаимодействие между участниками образовательного процесса (web-адрес 

http://edu.kemguki.ru/ ). 

Научно-исследовательская и проектно-творческая деятельность обучающихся в рамках 

дисциплины «Компьютерные технологии в дизайне» предполагает широкое обращение к 

информационным ресурсам сети Интернет. В учебных лабораториях кафедры дизайна 

имеется постоянный доступ всех обучающихся к сети Интернет. 

Применение мультимедийных электронных презентаций осуществляется в трех 

направлениях: 1) как учебно-наглядный ресурс преподавателя на лекционных, практических 

и индивидуальных занятиях; 2) как доступный для всех студентов учебно-наглядный ресурс 

в электронной образовательной среде КемГИК; 3) как форма фиксации теоретических и 

практических разработок студентов, с которыми они выступают на защите дизайн-проектов, 

выпускных квалификационных работ, на презентациях и научных конференциях (web-адрес 

http://edu.kemguki.ru/ ). 

 

6. Учебно-методическое обеспечение самостоятельной работы обучающихся 

Перечень учебно-методического обеспечения для самостоятельной работы 

обучающихся 

Организационные ресурсы 

http://edu.kemguki.ru/
http://edu.kemguki.ru/
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• Положение об учебно-творческих работах студентов  

Учебно-программные ресурсы 

• Рабочая программа дисциплины  

Учебно-теоретические ресурсы 

• Учебное пособие  

Учебно-практические ресурсы 

• Сборники творческих работ  

Учебно-методические ресурсы 

• Методические указания по выполнению самостоятельной работы 

• Учебный терминологический словарь  

Учебно-наглядные ресурсы 

• Электронные презентации 

• Альбом с образцами учебно-творческих работ  

Учебно-библиографические ресурсы 

• Список рекомендуемой литературы  

Средства диагностики и контроля 

• Контрольные вопросы 

• Тестовые задания 

Данные ресурсы размещены в «Электронной образовательной среде КемГИК» (web-

адрес http://edu.kemguki.ru/ ). 
 
Основные виды самостоятельной работы обучающихся: 

• научно-исследовательская работа; 

• подготовка творческих работ для участия в конкурсах и фестивалях 

международного и всероссийского уровня; 

• анализ, сравнение информационных и программных средств, форматов данных, 

выбор наиболее эффективных средств реализации проекта. 
 
Методические указания для обучающихся по организации самостоятельной 

работы 

Самостоятельная работа обучающихся по направлению 54.03.01 «Дизайн» 

(графический дизайн) является важнейшей частью учебного процесса в вузе. В 

профессиональной среде дизайнеров бытует поговорка: «Научить дизайну нельзя, а 

научиться можно». В определенных аспектах эта поговорка соответствует действительности. 

В овладении искусством графического дизайна большую роль играет мотивационно-

личностный компонент обучающихся: активность и вариативность в решении учебно-

творческих задач, ответственность, самостоятельность, инициативность, творческий подход. 

Самостоятельная работа обучающихся - особая форма организации учебного процесса, 

представляющая собой планируемую, организационно и методически направляемую 

деятельность студентов, ориентированную на достижение конкретного результата, 

осуществляемую без прямой помощи преподавателя. 

Содержание самостоятельной работы обучающихся по данной дисциплине направлено 

на: 
• формирование и развитие исследовательских умений; 
• развитие творческого потенциала обучающихся; 

• развитие мотивационных факторов. 

Конкретное содержание самостоятельной работы, ее виды и объем могут иметь 

вариативный и дифференцированный характер. Аудиторная самостоятельная работа по 

дисциплине выполняется на учебных занятиях под непосредственным руководством 

преподавателя и по его заданию. Внеаудиторная самостоятельная работа выполняется по 

заданию преподавателя, но без его непосредственного участия. 

Состав и содержание самостоятельной работы по изучению курса: предпроектный 

анализ по темам курса и художественно-образное решение по темам практических работ. 

http://edu.kemguki.ru/
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Творческие задания требуют интенсивной самостоятельной деятельности, в результате 

которой студент находит оригинальное решение учебной задачи, проводит активное 

осмысление материала, поиск вариативных решений, анализ проблемной ситуации, 

выполнение логических операций. 

Самостоятельная работа может осуществляться в письменной (подготовка 

мультимедийных презентаций и т.п.) или аналитической (анализ, сравнение 

информационных и программных средств, форматов данных, выбор наиболее эффективных 

средств реализации проекта) форме. Научно-исследовательская работа сопровождает все 

этапы проектирования: предпроектный анализ, разработку концепции и идей проекта, 

разработку стилистики и основных визуальных и художественных образов. Результаты 

самостоятельной исследовательской работы фиксируются в пояснительных записках к 

проектам, в выступлениях на научных студенческих конференциях. 
 

Содержание самостоятельной работы обучающихся 

Темы для самостоятельной 
работы обучающихся 

Количество часов 

Виды и содержание самостоятель-
ной работы 

очная 
форма 
обуче-

ния 

кон-
троль 

заочная 
форма 
обуче-

ния 

кон-
троль 

Раздел 1. Аппаратные и про-

граммные средства IBM-

совместимых персональных 

компьютеров (РС). Работа в 

среде локальных и глобаль-

ных компьютерных сетей 

14 - 22 1 Аналитические и проектные раз-

работки.  

Самостоятельное изучение теоре-

тического материала. 

Подготовка к тестированию. 

Мультимедийная презентация. 

Раздел 2. Пакет прикладных 

программ Microsoft Office 

14 9 22 1 Аналитические и проектные раз-

работки.  

Самостоятельное изучение теоре-

тического материала. 

Подготовка к тестированию. 

Мультимедийная презентация. 

Раздел 3. Специализирован-

ные профессионально ори-

ентированные программные 

средства 

16 9 22 1 Аналитические и проектные раз-

работки.  

Самостоятельное изучение теоре-

тического материала. 

Подготовка к тестированию. 

Мультимедийная презентация. 

Раздел 4. Специализирован-

ные профессионально ори-

ентированные программные 

средства 

65 9 123 6 Аналитические и проектные раз-

работки.  

Самостоятельное изучение теоре-

тического материала. 

Подготовка к тестированию. 

Мультимедийная презентация. 

Итого: 109 27 189 9  
 

7. Фонд оценочных средств 
Включает оценочные средства для текущего контроля успеваемости и для промежу-

точной аттестации по итогам освоения дисциплины. Структура и содержание фонда оценоч-

ных средств представлены в электронной информационно-образовательной среде 

https://edu2020.kemgik.ru/course/view.php?id=3359&sesskey=ffvN5BGOEb  и на сайте КемГИК 

https://kemgik.ru/.  
Оценочные средства для текущего контроля успеваемости 
Текущий контроль знаний студентов осуществляется при выполнении и сдаче работ.  

https://edu2020.kemgik.ru/course/view.php?id=3359&sesskey=ffvN5BGOEb
https://kemgik.ru/
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Оценочные средства для промежуточной аттестации по итогам освоения 
дисциплины 

 
Образцы контрольных вопросов для промежуточной аттестации 
1. Основные понятия информатики. Дискретная и непрерывная информация. 

Единицы измерения объема данных. 

2. Структурная схема компьютера. Организация памяти персонального компью-

тера. 

3. Структура программного обеспечения современного персонального компьюте-

ра и назначение отдельных составляющих программного обеспечения. 

4. Основные функции и свойства операционной системы Windows. 

5. Организация файловой системы операционной системы Windows. 

6. Устройства ввода/вывода персонального компьютера и их функции. 

7. Общие сведения о пакете прикладных программ Microsoft Office (состав паке-

та, назначение отдельных программ). 

8. Локальные и глобальные компьютерные сети, их основные характеристики. 

Структура сети Internet. 

9. Защита информации в локальных и глобальных компьютерных сетях, антиви-

русная защита. 

10.  Представление цвета в компьютерной графике. 

11.  Цветовые модели CMYK и RGB. Преимущества и недостатки. 

12.  Структура растровой графики. Основные приемы обработки растровых изоб-

ражений. 

13.  Структура векторной графики. Основные приемы работы с векторными изоб-

ражениями. 

14. Алгоритм создания 3D графики. 

 

Критерии оценки  

Тип 

зада-

ния 

Уровень 

нулевой пороговый повышенный продвинутый 

Оценка 

неудовлетво-

рительно 

удовлетвори-

тельно 
хорошо отлично 

Ответ 

на эк-

замене 

Отсутствие 

структуры 

ответа на во-

прос, не зна-

ние термино-

логии, не зна-

ет значитель-

ной части 

программного 

материала, 

допускает 

существенные 

ошибки, с 

большими за-

труднениями 

выполняет 

практические 

задания, зада-

Конспективный 

ответ на вопрос, 

умение кратко и 

точно передать 

суть ответа на по-

ставленный во-

прос, усвоил 

только основной 

материал, но не 

знает отдельных 

деталей, допуска-

ет неточности, 

недостаточно 

правильные фор-

мулировки, нару-

шает последова-

тельность в изло-

жении программ-

Краткое освеще-

ние всех аспектов 

предложенного 

вопроса, обучаю-

щийся твердо зна-

ет программный 

материал, грамот-

но и по существу 

излагает его, не 

допускает суще-

ственных неточ-

ностей в ответе на 

вопрос, может 

правильно приме-

нять теоретиче-

ские положения и 

владеет необхо-

димыми умения-

Детальное освещение 

всех аспектов предло-

женного вопроса, хо-

рошее владение терми-

нологией. глубоко и 

прочно усвоил весь 

программный матери-

ал, исчерпывающе, по-

следовательно, грамот-

но и логически стройно 

его излагает, не затруд-

няется с ответом при 

видоизменении зада-

ния, свободно справля-

ется с задачами и прак-

тическими заданиями, 

правильно обосновыва-

ет принятые решения, 
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чи.. 

 

ного материала и 

испытывает за-

труднения в вы-

полнении практи-

ческих заданий. 

ми и навыками 

при выполнении 

практических за-

даний 

умеет самостоятельно 

обобщать и излагать 

материал, не допуская 

ошибок. 

 

Примерная тематика мультимедийных презентаций 

1. Предмет компьютерной графики (КГ). Направления КГ. Области применения КГ. 

Современные тенденции развития КГ. 

2. История развития КГ. Современные тенденции развития КГ. 

3. Основные понятия КГ. Аппаратное обеспечение КГ (видеоадаптеры, дисплеи, типы 

дисплеев). Принципы формирования изображения на дисплее. 

4. Растровая графика. 

5. Векторная, фрактальная, трехмерная графики. 

6. Аппаратные средства и методы получения и обработки растровых изображений. 

7. Форматы графических данных. 

8. Цветовые модели. 

9. Цветовые палитры. 

10. Растровый графический редактор MS Paint. 

11. Растровый графический редактор Adobe Photoshop. 

12. Программа Adobe InDesign. 

13. Векторный графический редактор Adobe Illustrator. 

14. Векторный графический редактор Corel Draw. 

15. Аддитивная модель (RGB). 

 

Критерии оценки 

Тип за-

дания 

Оценка 

неудовлетво-

рительно 

удовлетворитель-

но 
хорошо отлично 

Мульти-

медийная 

презен-

тация 

Не раскрыта 

заявленная те-

ма, не соблю-

дены правила 

создания муль-

тимедийных 

презентаций 

Скупо и поверх-

ностно раскрыта 

заявленная тема, 

соблюдены пра-

вила создания 

мультимедийных 

презентаций 

Раскрыта заяв-

ленная тема, 

соблюдены 

правила созда-

ния мультиме-

дийных пре-

зентаций 

Глубоко раскрыта за-

явленная тема, пока-

заны знания (по ис-

пользованию мульти-

медиа) создания 

мультимедийных пре-

зентаций 

 

Тест по дисциплине 

 

Н
о
м

ер
 

за
д

а-

н
и

я 

Содержание задания 

К
о
м

п
ет

ен
ц

и
я
 

1.  Рассортируйте устройства на устройства ввода и вывода информации: 

А) монитор, Б) клавиатура, В) мышь, Г) принтер, Д) сканер, Е) CD-ROM, 

Ж) модем, 

УК-4 
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 З) микрофон, И) дисковод, К) наушники. 

2.  Как называется процесс разбиения изображения или звука на фраг-

менты меньшего размера: 

А) моделирование;  

Б) формализация;  

В) дискретизация;  

Г) кодирование. 

ПК-4 

3.  Выберите   правильный ответ, который является продолжением фра-

зы: «Текстовый редактор - это программа, предназначенная для …»  

А) создания, редактирования и форматирования текстовой информации; 

Б) работы с изображениями в процессе создания игровых программ; 

В) управления ресурсами ПК при создании документов; 

Г) автоматического перевода с символических языков в машинные коды. 

УК-4 

4.  Объектами в графическом редакторе Photoshop являются: 

А) линия, круг, прямоугольник, текст; 

Б) выделение, копирование, вставка; 

В) карандаш, кисть, ластик, ножницы; 

Г) набор цветов. 

ПК-4 

5.  Выберите все расширения текстовых файлов: 

А) exe; Б) txt;  В) bmp;  Г) avi;  Д) gif;  Е) doc;  Ж) wav. 

УК-4 

6.  Какие из нижеперечисленных действий можно выполнять с помощью 

инструмента Градиент (Gradient)? (2 ответа). Выберите несколько от-

ветов: 

1. Смешать градиентный переход между выбранными цветами. 

2. Задать направление и распределить градиентную заливку внутри объекта. 

3. Создать плавное превращение одной формы в другую. 

4. Распределить один градиент между несколькими объектами. 

ПК-4 

7.  Определите, как называется сеть, которая объединяет компьюте-

ры, установленные в одном помещении или одном здании: 

А) глобальная; 

Б) региональная; 

В) локальная; 

Г) корпоративная. 

УК-4 

8.  Каким образом выполняется зеркальное отражение растровых изобра-

жений внутри Adobe InDesign? Выберите один ответ: 

1. Adobe InDesign не может выполнить подобную операцию, поэтому зер-

кальное отражение необходимо сделать заранее в Adobe Photoshop. 

2. Необходимо выделить изображение и вызвать команду 

Object⇒Transform⇒Flip... 

3. Необходимо выделить изображение и вызвать команду 

Object⇒Transform⇒Rotate 180°. 

4. Вызвать команду View⇒Rotate Spread… 

ПК-4 

9.  Адрес текущей (выделенной) ячейки отображается: 

1) в поле имени; 

2) в строке формул; 

3) в пункте “Формат” текстового меню; 

4) в строке состояния. 

УК-4 

10.  Как быстро скрыть из видимости все направляющие, сетки, служеб-

ную подсветку объектов и прочие служебные элементы? Выберите 

один ответ: 

1. Выбрать команду View⇒Hide Edges. 

2. Нажать на клавиатуре клавишу W. 

ПК-4 
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3. Выбрать команду View⇒Hide Baseline Grid 

4. Выбрать команду View⇒Hide Guides 

11.  Если в ячейке электронной таблицы отображается последовательность 

символов ######, то это означает, что: 

1) формула записана с ошибкой; 

2) в формуле есть ссылка на пустую клетку; 

3) в формуле есть циклическая ссылка; 

4) столбец недостаточно широк. 

УК-4 

12.  Палитра Swatches в Adobe Illustrator предназначена для хранения и 

отображения:  

1. готовых образцов изображений  

2. образцов заливок всех видов, которые можно применить к контурам  

3. образцов декоративных заливок, которые можно применить к контурам  

ПК-4 

13.  В электронной таблице выделена группа из 12 ячеек. Она может быть 

описана диапазоном адресов: 

1) А1:В3; 

2) А1: В 4; 

3) А1:С3; 

4) А1: С4. 

УК-4 

14.  Можно ли применить инструмент градиент сразу к нескольким объек-

там:  

1. Да  

2. Нет  

3. Только если объекты сгруппированы 

ПК-4 

15.  Какую команду из текстового меню нужно выбрать, при необходимо-

сти включить или выключить режим отображения формул на листе 

электронной таблицы: 

1. Файл / Свойства; 

2. Сервис/ Настройка; 

3. Сервис/ параметры; 

4. Вставка/ Функция 

УК-4 

16.  Что произойдет, если ввести значение толщины линии без указания 

единицы измерения:  

1. Программа воспримет значение в миллиметрах  

2. Программа воспримет значение в пунктах  

3. Выдаст ошибку, т.к. обязательно определять единицы измерения 

ПК-4 

 

Критерии оценивания 

Знания, умения и навыки обучающихся определяются оценками «отлично», «хоро-

шо», «удовлетворительно», «неудовлетворительно». 

«Отлично» выставляется, если обучающийся достиг продвинутого уровня фор-

мирования компетенций - обучающийся глубоко и прочно усвоил весь программный мате-

риал, исчерпывающе, последовательно, грамотно и логически стройно его излагает, не за-

трудняется с ответом при видоизменении задания, свободно справляется с задачами и прак-

тическими заданиями, правильно обосновывает принятые решения, умеет самостоятельно 

обобщать и излагать материал, не допуская ошибок. 

«Хорошо» выставляется, если обучающийся достиг повышенного уровня форми-

рования компетенций - обучающийся твердо знает программный материал, грамотно и по 

существу излагает его, не допускает существенных неточностей в ответе на вопрос, может 

правильно применять теоретические положения и владеет необходимыми умениями и навы-

ками при выполнении практических заданий. 

«Удовлетворительно» выставляется, если обучающийся достиг порогового 
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уровня формирования компетенций - обучающийся усвоил только основной материал, но 

не знает отдельных деталей, допускает неточности, недостаточно правильные формулиров-

ки, нарушает последовательность в изложении программного материала и испытывает за-

труднения в выполнении практических заданий. 

«Неудовлетворительно» соответствует нулевому уровню формирования компе-

тенций; обучающийся не знает значительной части программного материала, допускает су-

щественные ошибки, с большими затруднениями выполняет практические задания, задачи. 

 

Шкала перевода баллов в оценки при промежуточной аттестации в форме экзамена 

Уровень формирова-

ния компетенции  

Оценка Минимальное ко-

личество баллов 

Максимальное 

количество бал-

лов 

Продвинутый Отлично 90 100 

Повышенный Хорошо 75 89 

Пороговый Удовлетворительно 60 74 

Нулевой  Неудовлетворительно 0 59 

 

Методические указания для обучающихся по освоению дисциплины 

Современные информационные системы состоят из нескольких видов обеспечиваю-

щих подсистем, к которым относятся: техническое, программное, информационное, органи-

зационное, правовое и эргономическое обеспечения. 

Техническое обеспечение представляет собой комплекс технических средств, обеспе-

чивающих функционирование информационной системы. В него входят персональные ком-

пьютеры, периферийное оборудование (принтеры, сканеры, плоттеры и т.д.), средства ком-

муникации и связи (модемы, сетевые платы и т.д.), а также средства оргтехники (ксероксы, 

факсы и т.д.). Средства оргтехники целесообразно включать в техническое обеспечение ин-

формационной системы, так как они органично встраиваются в систему сбора, передачи и 

обработки информации и являются неотъемлемым атрибутом современного офиса. Кроме 

того, функции принтера, ксерокса, факса выполняет одно устройство. Выбор необходимого 

состава технических средств должен определяться прежде всего функциональными задачами 

информационной системы и соответствующей предметной областью. 

Программное обеспечение — это совокупность программ и документации на них, ре-

ализующих основные функции информационной системы. Рынок программного обеспече-

ния, предназначенный для реализации задач в области дизайна, достаточно обширен. Необ-

ходимость разработки собственного программного обеспечения возникает только при реше-

нии уникальных задач. 

Информационное обеспечение представляет собой совокупность информационной ба-

зы предметной области и средств и методов ее обработки. Создание информационной базы в 

области дизайна является одной из сложнейших проблем. 

Прежде всего, встают вопросы проектирования информационной базы, которые яв-

ляются определяющим условием успешной работы всей системы в будущем. Не менее тру-

доемкой задачей является наполнение информационной базы конкретными данными. 

Организационное обеспечение представляет собой комплекс методов и правил орга-

низации работы с информационной системой, а также описание должностных инструкций 

пользователей информационной системы. В сложных информационных системах этот вид 

обеспечения играет весьма важную роль, так как он определяет порядок функционирования 

информационной системы. Несоблюдение правил пользования информационной системой и 

невыполнение должностных инструкций могут привести к неадекватности базы данных и, 

как следствие, к принятию неправильных управленческих решений. 

Правовое обеспечение включает в себя комплекс правовых норм и прав пользователей 

информационной системы. Эта подсистема обеспечивает ограничение доступа к данным 

различных категорий пользователей, как правило, путем организации парольного доступа. 
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Кроме того, в настоящее время одними из важнейших вопросов становятся проблемы 

защиты информации от несанкционированного доступа. 

Эргономическое обеспечение предполагает разработку рекомендаций и норм пра-

вильной организации рабочего места пользователя системы, в том числе правильное распо-

ложение компьютеров в помещении, соблюдение необходимого уровня освещенности, уста-

новление нормирования работы пользователя за компьютером и т. п. 

 

8. Учебно-методическое и информационное обеспечение дисциплины 

8.1. Основная литература 

1. Молочков, В.П. Adobe Photoshop CS6 / В.П. Молочков. - 2-е изд., испр. - 

Москва : Национальный Открытый Университет «ИНТУИТ», 2016. - 339 с.: ил. - 

URL: http://biblioclub.ru/index.php?page=book&id=429052 . (дата обращения: 16.05.2020).  – 

Режим доступа:  Университетская библиотека online.  – Текст : электронный. 

2. Молочков, В.П. Макетирование и верстка в Adobe InDesign / В.П. Молочков. - 

2-е изд., испр. - Москва : Национальный Открытый Университет «ИНТУИТ», 2016. - 358 с. : 

ил. - Библиогр. в кн. - URL: http://biblioclub.ru/index.php?page=book&id=429055 . (дата обра-

щения: 16.05.2020).  – Режим доступа:  Университетская библиотека online.  – Текст : элек-

тронный. 

3. Божко, А.Н. Ретушь и коррекция изображений в Adobe Photoshop / А.Н. Божко. 

- 2-е изд., исправ. - Москва : Национальный Открытый Университет «ИНТУИТ», 2016. - 427 

с. : схем., ил. - URL: http://biblioclub.ru/index.php?page=book&id=428789 . (дата обращения: 

16.05.2020).  – Режим доступа:  Университетская библиотека online.  – Текст : электронный. 

8.2. Дополнительная литература 

1. Аббасов, И.Б. Основы трехмерного моделирования в графической системе 3ds 

Max 2009 : учебное пособие / И.Б. Аббасов. — Электрон. дан. — Москва : ДМК Пресс, 2009. 

— 176 с. — URL: https://e.lanbook.com/book/1341. (дата обращения: 16.09.2020).  – Режим до-

ступа:  Университетская библиотека online.  – Текст : электронный. 

2. Современные информационные технологии : учебное пособие / В.И. Лебедев, 

О.Л. Серветник, А.А. Плетухина и др. ; Министерство образования и науки Российской Фе-

дерации, Федеральное государственное автономное образовательное учреждение высшего 

профессионального образования «Северо-Кавказский федеральный университет». - Ставро-

поль : СКФУ, 2014. - 225 с. : ил. - Библиогр. в кн. ; То же [Электронный ресурс]. - 

URL: http://biblioclub.ru/index.php?page=book&id=457747 . (дата обращения: 16.05.2020).  – 

Режим доступа:  Университетская библиотека online.  – Текст : электронный. 

3. Несен, А. В. MicrosoftWord 2010: от новичка к профессионалу [Электронный 

ресурс] / А. В. Несен. – Электрон. дан. - Москва: ДМК Пресс, 2011. - 449 с. - (Университет-

ская библиотека online: электрон. библ. система). - URL: 

http://biblioclub.ru/index.php?page=book&id=129623. – . (дата обращения: 16.05.2020).  . – Ре-

жим доступа:  Университетская библиотека online.  – Текст : электронный. 

4. Исакова, А. И. Информационные технологии [Электронный ресурс]: учебное 

пособие / А. И. Исакова, М. Н. Исаков. – Электрон. дан. - Томск: Эль Контент, 2012. - 174 с. - 

(Университетская библиотека online: электрон. библ. система). - URL: 

http://biblioclub.ru/index.php?page=book&id=208647. – . (дата обращения: 16.05.2020).  . – Ре-

жим доступа:  Университетская библиотека online.  – Текст : электронный. 

5. Ракитов, А. И. Философия компьютерной революции [Электронный ресурс] / 

А. И. Ракитов. – Электрон. дан. - Москва: Директ-Медиа, 2013. - 291 с. - (Университетская 

библиотека online: электрон. библ. система). - URL: 

http://biblioclub.ru/index.php?page=book&id=210487. – . (дата обращения: 16.05.2020).  . – Ре-

жим доступа:  Университетская библиотека online.  – Текст : электронный. 

8.3. Ресурсы информационно-телекоммуникационной сети «Интернет» 

1. Информационная система «Единое окно доступа к образовательным ресурсам» 

: база данных - Электрон. дан. - Москва: ФГАУ ГНИИ ИТТ «Информика», 2005-2018. - URL: 

http://biblioclub.ru/index.php?page=book&id=429052
http://biblioclub.ru/index.php?page=book&id=429055
http://biblioclub.ru/index.php?page=book&id=428789
http://biblioclub.ru/index.php?page=book&id=457747
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http://window.edu.ru/. - . (дата обращения: 16.05.2020).  . – Режим доступа:  Информационная 

система.  – Текст : электронный. 

2. Научная электронная библиотека eLIBRARY.RU: электрон. информ. портал - 

Электрон. дан. - Москва, 2000-2018. - URL: http://elibrary.ru/. (дата обращения: 16.05.2020).  – 

Режим доступа:  Научная электронная библиотека eLIBRARY.RU.  – Текст : электронный. 

3. Федеральный портал «Российское образование» : электрон. информ. портал. - 

Электрон. дан. - Москва: ФГАУ ГНИИ ИТТ «Информика», 2002-2018. - URL: 

http://www.edu.ru/. - (дата обращения: 16.05.2020).  – Режим доступа:  Портал «Российское 

образование».  – Текст : электронный. 

4. Информационный центр «Ресурсы образования» : сайт. – Электрон. дан. – 

Москва: МЦФЭР, 2011. – URL: : www.resobr.ru/. – (дата обращения: 16.05.2020).  – Режим 

доступа:  Ресурсы образования.  – Текст : электронный. 

5. Министерство культуры РФ : официальный сайт. – URL: 

http://www.mkrf.ru/.(дата обращения: 16.05.2020).  – Режим доступа:  Минкульт РФ.  – Текст : 

электронный. 

6. Министерство образования РФ : официальный сайт. – URL: https://xn--

80abucjiibhv9a.xn--p1ai/.(дата обращения: 16.05.2020).  – Режим доступа:  Минобр РФ.  – 

Текст : электронный. 

7. Российская государственная библиотека : официальный сайт. – URL: 

https://www.rsl.ru/ (дата обращения: 16.05.2020).  – Режим доступа:  Российская государ-

ственная библиотека.  – Текст : электронный. 

 

8.4.Программное обеспечение и информационные справочные системы 

лицензионное программное обеспечение: 

- операционная система MS Windows (10, 8,7, XP);  

- офисный пакет Microsoft Office (MS Word, MS Office Power Point);  

- антивирусные программные средств Каspersky Endpoindt Security для Windows. 

- графические редакторы Adobe CS6 Master Collection, CorelDRAW Graphics Suite X6. 

информационные справочные системы - Консультант Плюс. 

 

9. Материально-техническое обеспечение дисциплины  

Лаборатории и кабинеты, оснащенные компьютерами с выходом в Интернет: 

• Лаборатория графического дизайна (№ 109, корпус 2 КемГИК); 

• Лаборатория компьютерной графики (№313, корпус 2 КемГИК); 

• Кабинет теории и истории дизайна (№ 110, корпус 2 КемГИК). 

Техническое оснащение: 
• мультимедийный проектор, экран - 1; 

• широкоформатные телевизоры - 3; 

 стационарные компьютеры - 12;  

 ноутбуки – 3. 

Информационный фонд: 
электронный информационный фонд визуальных материалов по разделам и темам 

дисциплины. 

 

10. Особенности реализации дисциплины для инвалидов и лиц с ограниченными 

возможностями здоровья 
Для обеспечения образования инвалидов и обучающихся с ограниченными 

возможностями здоровья с нарушением опорно-двигательного аппарата имеется 

возможность посещать занятия в инвалидной коляске в аудиториях кафедры, которые 

находятся на 1-м этаже корпуса №2 КемГИК. 

http://window.edu.ru/
http://elibrary.ru/
http://www.edu.ru/
http://www.mkrf.ru/
https://www.rsl.ru/
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Применяется индивидуальный подход к освоению дисциплины, индивидуальные 

задания: при необходимости натурные зарисовки могут быть заменены на работы, 

выполненные с помощью компьютера и наоборот. 

Исходя из доступности для инвалидов и лиц с ограниченными возможностями 

здоровья применяются следующие методы обучения: 

• дистанционные методы (максимальное использование возможностей ЭОС 

КемГИК при получении учебного задания, консультаций и сдачи проекта); 

• метод визуализации идеи при подготовке дизайн-проекта с предоставлением 

нескольких вариантов графического решения; 

• метод концептуализации образа при возникновении трудностей с разработкой 

концепции проекта и его основных идей. 

Для осуществления процедур текущего контроля успеваемости и промежуточной 

аттестации обучающихся инвалидов и лиц с ограниченными возможностями здоровья - 

установлены адаптированные формы проведения с учетом индивидуальных 

психофизиологических особенностей: 

- для лиц с нарушением зрения - задания предлагаются с укрупненным шрифтом; -для 

лиц с нарушением слуха - оценочные средства предоставляются в письменной форме с 

возможностью замены устного ответа на письменный ответ; 

-для лиц с нарушением опорно-двигательного аппарата - двигательные формы 

оценочных средств - заменяются на письменные или устные с исключением двигательной 

активности. 

При необходимости студенту-инвалиду предоставляется дополнительное время для 

выполнения задания. 

При выполнении заданий для всех групп лиц с ограниченными возможностями 

здоровья допускается присутствие индивидуального помощника-сопровождающего для 

оказания технической помощи в оформлении результатов проверки сформированности 

компетенций. 

 

11. Перечень ключевых слов 
Цифровые системы 

Цифровое представление данных  

Программное обеспечение компьютеров 

Компьютерные технологии /графика, мета-вычисления  

Обработка данных / обмен данными, промежуточное программное обеспечение 

Сервис файловой системы 

Пакет «офисных» прикладных программ Microsoft Office и Open Office 

Оптическое распознавание текста, качество распознавания 

Локальные и глобальные компьютерные сети 

Защита информации в локальных и глобальных компьютерных сетях 

Программное обеспечение в области издательских систем 

Цветоделение 

Модульная сетка 

Векторная графика  

Растровая графика 

Трехмерная графика 
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